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 Lesson 1 : Introduction to computer and 

Computer Languages 

A. Multiple choice questions: 

1. electronic 2. China

3. binary 4. 1958

5. Assembler 6. Device Driver

B. State true or false :

1. True 2. False 3. True

4. False 5. False

C. Fill in the blanks : 

1. palmtop 2. Hardware 

3. Mini Computer 4. Language Processor 

5. Computer

D. Answer the following questions in short: 

1. A computer is an electronic device which consist of 

Hardware and Software. 

2. First-generation computers relied on binary-coded 

language, which is also known as the machine language 

(i.e. language of 0s and 1s), to perform operations.

3. Every computer system comprises the following 

components : 

* Input Unit * Output Unit

4. Language processors are those software programs that 

translate programming languages to a machine 

understandable form. 

5. Various high level languages are BASIC, COBOL, 

FORTRAN, C, C++. 

E. Answer the following questions in detail :

1. The computer used in different generations are :

First Generation (1940-56) – Vacuum tubes 

Second Generation (1956-63) – Transistors 
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Third Generation (1964-70) – Integrated Circuits

Fourth Generation (1970-till date) – Microprocessors

Fifth Generation (Present and Beyond) – Artificial 

    Intelligence 

2. INTERPRETER : 

An interpreter translates a program one line at a time 

and executes the translated instruction before proceeding 

to next lines. 

It converts a high level language program into machine 

language line by line. 

While translating the interpreter keeps checking for 

errors and stops if it finds one. 

COMPILER : 

A compiler translates the entire program written in a 

high level language into a machine language in one go. 

If the conversion fails due to errors present in program

all the errors are removed and the program is recompiled. 

3. Utility software is a computer software designed to help 

in the management and tuning of operating systems, 

computer hardware and application software. It is 

designed to perform a single task or a multiple of small 

tasks. Examples of utility software's include Disk 

defragmenters, System Profilers, Network Managers, 

Application Launchers and Virus Scanners. 

4. Following are the characteristics of Fourth Generation 

computers :

. Use of microprocessor-based systems. 

. Very small in size. 

. Cheapest among all the other-generation computers. 

. Portable and quite reliable. 

 Hardware failure is negligible, so minimum 

maintenance is required. 

. Production cost is very low.
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5. Machine Language : This is the language (in the form of 

0’s and 1’s  called binary numbers.) understood directly 

by the computer. It is machine dependent. It is difficult 

to learn ad even more difficult to write programs.

Assembly Language : Assembly language programming is 

simpler and less time consuming than machine 

language.  It is easier to locate and correct errors than 

machine language. It is also machine dependent. 

6. System Software : 

. System software refers to the files and programs 

that make up your computer's operating system. 

. The programs that are part of the system software 

include assemblers, compilers, file management 

tools, system utilities, and debuggers. 

. The system software is installed on your computer 

when you install your operating system.

. System software runs at the most basic level of 

your computer, it is called "low-level" software.

Application Software : 

. Application software is a program or group of 

programs designed for end users. 

. These programs are divided into two classes: 

system software and application software. 

. "While system software consists of low-level 

programs that interact with computers at a basic 

level, application software resides above system 

software and includes database programs, word 

processors. spreadsheets, etc. 

. Application software is a set of programs necessary 

to carry out operations for a specified application. 

These are the programs written by programmers 

to enable computers to perform a specific task.
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 Lesson 2 : Formatting with MS Word

A. Multiple choice questions: 

1.  information 2. Drop Cap

3. 5 4. Format

5. Vertical 6. Thesaurus

B. State true or false :

1. True 2. True 3. False

4. True 5. True 6. True

C. Fill in the blanks : 

1. MS Word 2. Header

3. Ctrl + Alt + F 4. Drop cap

5. Preset 6. dictionary 

7. Page orientation

D. Answer the following questions in short: 

1. MS Word is a word processing program. The purpose of 

MS Word is to type and save documents  

2. Headers and footers are parts of a document that 

contain special information such as page numbers and 

the total number of pages, the document title, company 

logo, any photo, etc.

3. A Format Painter is a very useful tool that helps to copy 

a format from specific portions of your document and 

apply it to other portions of your document with a few 

clicks. 

4. Thesaurus is a dictionary of synonyms, words and 

phrases that mean the same thing as a particular word 

or phrase. It is just like a dictionary and can be used to 

replacing a word with one of its synonyms. 

E. Answer the following questions in detail :

1. Steps to use Format Painter : 

. Select the text or graphic that has the formatting 

that you want to copy. 

. On the Home tab, in the Clipboard group, click 
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Format Painter. The pointer changes to a 

paintbrush Icon. 

. Select the text or graphic that you want to format.

. To stop formatting, press ESC.  

2. Click anywhere on the paragraph you want to indent 

left and click Increase Indent button available on Home 

tab or simply press Ctrl + M keys. You can click multiple 

times to create deeper indentation. 

3. Steps to use Drop Cap 

. Click on Insert tab. 

. Click on the Drop Cap option. 

. Select the Dropped option from the Position box.

. Select the desired font of the dropped letter from 

the Font: drop-down list in Option section. 

. Select the desired option from the Lines to drop: 

drop-down list. 

. Increase the distance between the text and the 

dropped letter with the help of Distance from 

text: drop-down list. 

. Click on OK.  

4. A Tab Stop refers to a preset text position. The Tab 

Stop feature allows you to set left, center, right, decimal, 

or bar tabs to line up columnar information. 

5. Paragraph Alignment refers to how the left and right 

edges of a paragraph are aligned. There are four types of 

alignments :

Left Alignment : Aligns the content with the left 

margin.  This is default alignment in MS Word. 

Center Alignment : Align the context in the center of 

the document. It is used to add titles to documents. 

Right Alignment : Aligns the content with right 

margin. It is used to add header and footer. 

Justified : Distributes text evenly on both margin. 
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F. Match the following :

1. e 2. c 3. f 4. g

5. a 6. d 7. b

Lesson 3 : Spreadsheet 

A. Multiple choice questions: 

1. office 2. category

3. formula bar 4. worksheet

5. remove 6. size

B. State true or false :

1. True 2. False 3. False

4. False 5. True 6. True

7. False

C. Fill in the blanks : 

1. MS Excel 2. modified

3. gridlines 4. grow font

5. standard 6. cell

D. Answer the following questions in short: 

1. It adds up all the values in a range of cells.

2. It calculates the average of the cell values.

3. It counts the cells values. 

4. Border formatting allows to add borders to individual 

cells to emphasize or define sections of a worksheet. 

E. Answer the following questions in detail :

1. Excel is a spreadsheet program in the Microsoft Office 

system. Excel allows to create and format workbooks in 

order to analyse data and make more informed business 

decisions. Excel is used to perform various calculations 

and a variety of professional looking chart. 

2. There are three ways to view a spreadsheet. Click on a 

page view button to select it.

. Normal view is selected by default, and shows you 
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an unlimited number of cells and columns. 

. Page Layout view divides your spreadsheet into 

pages.

. Page Break view lets you see an overview of your 

spreadsheet.

3. Steps to modified data :

. Click on the cell having the data that needs to be 

changed. 

. Replace it with the new data. 

. Press the Enter key on the keyboard. You may also 

click on the Enter button on the Formula Bar. 

4. Steps to change font size :

. Select the cells you want to modify. 

. Click the drop-down arrow next to the Font Size 

command on the Home tab. The Font Size drop-

down menu appears. 

. Move your mouse over the various font sizes. A 

live preview of the font size will appear in the 

worksheet. 

. Select the font size you want to use.  

5. If the formula or a function is typed incorrectly, 

sometimes errors are displayed in the working cells or 

the Formula Bar in place of the results. A list of some 

common errors displayed in MS Excel, and their possible 

reasons are given following. 

Error message displayed Possible reasons

1. ##### a. The column is not 

wide enough to 

display the result or 

the value. 

2. #DIV/O! b. Division by zero error 

(invalid operation).
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3. #N/A c. Data unavailable 

4. #VALUE! d. Invalid data 

F. Do yourself.

G. Do yourself.

Lesson 4 : MS PowerPoint

A. Multiple choice questions: 

1. Blank presentation 2. consecutive

3. thumbnail 4. arrow

5. menus

B. State true or false :

1. True 2. False 3. True

4. True 5. True 6. True

C. Fill in the blanks : 

1. Ms PowerPoint 2. thumbnail

3. design tab 4. Slide area 

5. easily 6. subtitle

D. Answer the following questions in short: 

1. MS PowerPoint is a presentation tool that supports text, 

shape, graphic, pictures and multimedia along with 

integration with excel. 

2. A template contain a blank presentation with already 

designed colours and graphics for slides. 

3. To create a New Presentation 

. Click the File tab and select New. Available 

Templates and Themes on your computer and the 

Office. com Templates site display. 

. Double-click the default, Blank presentation icon 

to open a new presentation based on this 

template. A Blank presentation opens in a new 

window . 

4. The Slide and Outline thumbnail views can be used to 

enter, view, or move text or slides.
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E. Answer the following questions in detail :

1.

2. When creating a presentation, the borders between the 

Slides, Notes, and thumbnails can be adjusted by 

dragging them with a mouse. When the mouse is 

positioned on a border, a two-headed arrow displays. 

The two-headed arrow can be used for resizing the 

Notes or Thumbnail panes. Presentation view buttons 

allow presentation slides to be viewed in the default 

"Normal" view, Slide Sorter view, Reading View, or as a 

Slide Show. 

3. . Click the File tab and select New. Available 

templates and themes display. 

. Under Available Templates and Themes, click 

Blank presentation 

. Return to the Available Templates and Themes 

window by clicking the Home button. You will 

find View Templates for New Presentations.

. Under Templates, click installed Themes and view 

the thumbnails. 

. Choose a desired theme and click Create. The 

selected theme is applied to the presentation. 

4. To create a New Presentation 

Consider the following points when creating a 

presentation.

8 Considerations 

8 Purpose of the presentation 

8 Audience 

8 Room size and light 

8 Equipment and software 

8 Templates 

8 Choose colour and a plain font (one to two fonts) 

that will display well in the room(s) where the 

presentation will be displayed. 
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. Click the File tab and select New. Available 

Templates and Themes on your computer and the 

Office. com Templates site display. 

. Double-click the default, Blank presentation icon 

to open a new presentation based on this 

template. A Blank presentation opens in a new 

window . 

5. On the Themes Gallery, click the Colors drop-down 

arrow to select from built-in color schemes or Create 

New Theme Colors to create an entirely new theme or 

to modify colours for specific areas.

6.

F. The options for deleting a table are in layout tab :

Select the table.

Under Table Tools group, click layout tab.

From Rows and Columns group, click Delete icon.

Select the Delete Table option. 

 Lesson 5 : Introduction to Programming

A. Multiple choice questions: 

1.  three 2. flowchart 3.      Algorithm 

To Insert a table in a presentation :

8 Click the slide where you want to insert the table.

8 Click the insert tab.

8 From the table group, click the table   icon.

8 The Insert table gallery appears.

8 Click Insert table.

8 From number of column spin box, select the 

number of columns you want to add.

8 From the number of rows spin box, select number 

of rows you want to add. 

8 Click OK

A table with specified number of rows and columns will 

be insert in your presentation. 

8
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4. oval 5. flow lines

B. State true or false :

1. True 2. True

3. True 4. False

5. False 6. True

C. Fill in the blanks : 

1. process 2. graphical

3. flow chart 4. Connector

5. independent

D. Match the following :

1. rectangle 2. diamond

3. parallelogram 4. circle

5. arrow

E. Answer the following questions in short: 

1. Command is an instruction given to the computer to 

perform certain task.

2. A set of logically arranged commands is called computer 

program. 

3. No proper syntax : An algorithm does not have specific 

rules of writing and thus do not have proper syntax.

4. Circle is used to connect the various sections of a 

flowchart to maintain its linear flow. 

F. Answer the following questions in detail :

1. An algorithm is a set of instructions given to computer 

to solve any mathematical or logical problem. In short, it 

may be defined as a step-by-step procedure to solve any 

problem. It is always written in simple Language and 

precise so that anybody can understand it better. 

2. We write a program on computer by following the 

given three steps :  

• Write an algorithm. 

• Design a flowchart based on the algorithm. 

• Conversion of flowchart into program. 
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3. Characteristics of an Algorithm 

• Input : It has a well defined input. 

• Output : It has a well defined output. 

• Finiteness : It has a fixed number of steps which 

are performed in time. 

• Well-ordered : All the instructions are given in 

right order. 

• Unambiguous : Each and every step has a clear 

and definite meaning without any ambiguity. 

• Effectiveness : It runs effectively in terms of 

memory usage, resources used and the time. 

4. Three advantages of an algorithm are :

• They are easy to understand and execute. 

• They make the removal of any type of error easy 

while solving out any problem.

• They are free from any language specification. 

5. Start or Stop box : It is used to indicate start or end of 

the algorithm. 

Input or Output box : It is used to indicate the input or 

output of data. 

Processing box : It is used to indicate the processing of 

data or some calculation. 

Decision box : It is used to indicate some decision 

making process on data. 

6. Limitations of a Flowchart 

• When the program logic is quite complicated, 

flowchart becomes complex to understand. 

• Designing a flowchart requires more space than 

writing an algorithm. 

• If some modifications are required, the flowchart 

may require re-drawing completely.

G. Define the following :

1. Decision box : It is used to indicate some decision 
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making process on data. 

2. Input or Output box : It is used to indicate the input or 

output of data. 

3. Processing box : It is used to indicate the processing of 

data or some calculation. 

4. Connector : It is used to connect the various sections of 

a flowchart to maintain its linear flow. 

H. Make a flow chart :

1. Start

Input A

Input B

A<B Print “B is smaller.”

Print “A is smaller.”

Stop

2. Start

Input L, B, H

Volume  L < B < H

Print Volume

Stop

Lesson 6 : Introduction to Scratch

A. Multiple choice questions: 

1. Sprite 2. stamp

3. pen up 4. Add extension

5. Menu bar

B. State true or false :

1. True 2. False

3. True 4. False

5. False

C. Fill in the blanks : 

1. Scratch 2. Stage 3. Pen

4. Motion block 5. Code blocks
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D. Answer the following questions in short: 

1. Scratch is one of the easiest computer language. It ha a 

platform that can be downloaded for free. 

2. Sprite is a small graphical character that perform actions 

in a project. It can be of any type, shape, color and size.

3. A script is created by joining blocks of either same or 

different categories. It is used to program a sprite. 

4. Code Blocks are like puzzle pieces that are used to 

create projects. It contain many set of blocks that are 

used to program a sprite.

5. Add Extensions allows to add extension of other blocks.

E. Answer the following questions in detail :

1. The main components of scratch window are :

a. Menu bar

b. Sprite

c. Stage

d. Code Blocks

e. Script

f. Script Area

g. Add Extension 

Sprite : It is a small graphical character that perform 

actions in a project. It can be of any type, shape, color 

and size. 

Stage : A sprite is placed on the stage to perform 

actions. It is the area where a sprite moves. It is divided 

into x and y coordinates.

Code Blocks : These are like puzzle pieces that are used 

to create projects. It contain many set of blocks that are 

used to program a sprite.

2. The pen block menu adds a pen to the sprite that can 

draw different figures on stage. Blocks of Ten Block 

Menu are :
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Pen Down Pen Up

Change Pen Colour Stamp

3. To save a project in scratch, follow these steps :

. Click on file menu in menu bar and select the save 

to your computer option from drop down list.

. The save as dialog box appears.

. Choose the desired location where you want to 

save your project and type a suitable name in File 

name box.

. Click on save button. 

4. Pen Down : This block adds a pen to a sprite. As the 

sprite moves on the stage, it draws a line or curve along 

with it.

Pen Up : This block removes the pen from sprite.

5. Stamp block is used to create a duplicate copy of sprite 

present on stage. 

 Lesson 7 :  QBASIC

A. Multiple choice questions: 

1.  programming 2. CLS

3. Print 4. Run

5. QBASIC 6. program

B. State true or false :

1. True 2. False

3. True 4. False

5. False 6. True

C. Fill in the blanks : 

1. .exe 2. Save as

3. GW Basic 4. Status bar

5. Menu 6. Program name

7. Exit
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D. Answer the following questions in short: 

1. Title Bar : The bar presents on the top of the window, is 

the Title bar. It displays the name of the program 

running along with the file name. 

2. Menu Bar : The Menu Bar is present just below the Title 

Bar. The Menu Bar has the following main menus: File, 

Edit, View, Search, Run, Debug, Options and Help.

3. To Exit from the QBASIC, we can use the following 

steps. 

File menu > Exit option  

4. Program Area is the actual workspace where you type a 

program. 

5. . It is a good language for beginners.

. This programming language is free.

. This programming language is very simple and 

easy to learn.

E. Answer the following questions in detail :

1. QBASIC is a programming language. BASIC stands for 

Beginner's All-purpose Symbolic Instruction Code. It 

belongs to the category of high-level programming 

languages. In 1985, Microsoft released the version of 

BASIC language called QBASIC with its MS DOS 5.0 

operating system. It basically supports Character User 

Interface (CUI).

2. The different components of QBASIC windows are :

Title Bar, Menu Bar, Program Area, Program Name, 

Horizontal Scrollbar, Vertical Scrollbar, Status Bar, 

Immediate Mode Area. 

3. The command 'CLS' stands for Clear Screen. It clears the 

content on the screen. To start the program, we use 

CLS command as the first line. This command can be 

used anywhere in a program. 
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4. . To write a simple program we can use CLS and  

PRINT. 

CLS 

A=3 

B =4 

PRINT A*B 

END  

. To execute or to run a QBASIC program click on 

Run menu—>Start option or Shift+ FS  

. The output screen occurs.  

5. . Click on File menu > Save As option. 

. After clicking on the Save As option, a dialog box 

appears. Give the suitable name to the file. Select 

the location where you want to save the file. 

. Click on OK. 

6. Operators perform mathematical or logical operations 

on value. The operators provided by BASIC can be 

divided into five categories :

a. Arithmetic Operator

b. Relational Operator

c. Logical Operator

d. Functional Operator

e. String Operator 

F. Define the following :

1. Status Bar : It displays the status of the current position 

of the cursor. It also displays the short-cut keys for the 

frequently used commands. 

2. Menu Bar : The Menu Bar is present just below the 

Title Bar. The Menu Bar has the following main menus: 

File, Edit, View, Search, Run, Debug, Options and Help. 
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3. Vertical Scrollbar : It helps to scroll either to the 

beginning or the end of the screen to see the lines that 

are not visible. 

4. Title Bar : The bar presents on the top of the window, 

is the Title bar. It displays the name of the program 

running along with the file name. 

5. Immediate Mode Area  : The mode in which a QBASIC 

statement is executed as soon as Enter key is pressed. 

6. Program Area : It is the actual workspace where you 

type a program. 

7. Horizontal Scrollbar : It helps to scroll either to the left 

or the right of the screen to see the program that is not 

visible. 

8. Program Name : It is displayed just below the Menu 

Bar. By default, it displays 'Untitled'. 

G. Output of the program :

1. Welcome to QBASIC 

QBASIC is a programming language

Let’s Enjoy

2. Welcome to QBASIC

I got it

It’s intersting 

Lesson 8 : Electronic Mail (E-mail)

A. Multiple choice questions: 

1.  1972 2. internet 3. Email

4. password 5. attachment

B. State true or false :

1. True 2. False 3. True
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4. False 5. True

C. Fill in the blanks : 

1. Electronic mail 2. G-mail

3. attachment 4. outgoing

5. viewing attachments

D. Answer the following questions in short: 

1. Email : Email, e-mail or electronic mail is the 

transmission of messages (emails or email messages) 

over electronic networks like the internet. 

2. Domain Name System (DNS) translates Internet domain 

and host names to IP addresses. 

3. Hostname is the name of the email server that provides 

email services. 

4. Email address is stored on the mail server, thus we 

receive some junk mails. These are called unwanted 

Emails. 

5. Attachments : Files that are sent through an e-mail.

E. Answer the following questions in detail :

1. We can use e-mail to

Í Send and receive messages :  You can send 

message and anyone around the world if you 

know person’s e-mail address.

Í Send Greetings : You can send greeting card 

through an e-mail.

Í Forward Messages : You can forward a mail 

received by you to another person.

Í Send Messages to group of People : You can 

send messages to group people at same time, at 

not extra cost. 
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2. E-mail address is a combination of a username and a 

hostname, and is written as username@hostname. For 

example parv@hotmail.com, samniceboyl@gmail.com. 

It is made up of 

User name : It can be any name given by the user. 

Host name : It is the name of the email server that 

provide email services. 

3. ADVANTAGES OF EMAIL 

Convenient : One advantage of email over the 

telephone or regular mail is its convenience. You can 

send a message at any time of day or night. 

Immediate : Your message is delivered instantly from 

your computer to any other computer whether it is in 

your locality or halfway around the world. 

Inexpensive : Email is less expensive than telephone 

calls, faxes, courier or postal service. 

LIMITATIONS OF EMAIL 

Unwanted emails : Since your email address is stored 

on the mail server, you may also receive some unwanted 

junk mails. 

Privacy concerns : You can secure your email accounts 

by entering a password. However, if someone knows 

your password, the person can easily access your 

account and may read or send messages through it.

4. The Compose page is the page on which you can write 

and address your outgoing E-mail messages. To access 

the Compose page, click Compose in the left-side 

navigation panel or click the email icon next to a name 

in your address book. 

5. It is important to close your email account properly. It 

ensures that no one else can access it without the 
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password. To sign out, you have to click on the Sign out 

option present at the top right corner of the screen. 

This will move you out of your account. 

 Lesson 9 : Internet

A. Multiple choice questions: 

1. 1969 2. Internet

3. FTP 4. Website

5. Google

B. Fill in the blanks : 

1. TCP 2. http://

3. servers 4. search engine

5. Internet 6. Protocol

C. State true or false :

1. False 2. True

3. True 4. True

5. False

D. Answer the following questions in short: 

1. Internet explorer is a web browser that was developed 

by Microsoft. It allows user to access and navigate 

websites, view multimedia content, etc. 

2. Hyper Text Transfer Protocol is the standard protocol 

for transferring web pages across the Internet. 

3. Simple Mail Transfer Protocol is a set of communication 

guidelines that allow software to transmit email over the 

Internet. 

4. Web browser is a software application in your laptop or 

your PC which is used to access the information from 

the Web. 
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5. URL identifies and locate any resource that is available 

on the internet.

URL strings consist of three parts : 

a. Network protocol 

b. Host name or address 

c. File or resource location 

E. Answer the following questions in detail :

1. Internet is a collection of computer networks and 

computer all of which are connected to each other so 

that user can share information and communicate to 

each other.  Internet was founded by ARPANET 

(Advance Research Project Agency) in 1969.

2. To get connected to the Internet what you need is : PC

A modem (Modulator - Demodulator) : It converts the 

digital signal from the PC to analog signal and vice-versa.

A browser : It is a software like Internet Explorer.

A telephone line : A telephone line is necessary as the 

messages are passed from one PC to the other via the 

telephone network. An ISP (Internet Service Provider)  :  

An ISP is a company that provide you access to the 

Internet. Some of them are : BSNL, MTNL, etc.

3. Various uses of Internet are -

Education : Internet plays a major role in education. 

Few basic education elements present on the Web are :

• Online tutorials Web Publishing 

• Online Forums 

• Easy navigation from source to source. 

Entertainment : People often use personal blogs to 

update friends on their lives, and they use social 
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networking sites to keep track of and communicate 

with friends. 

Streaming media : Internet allows to download media. 

Online media on your TV : Internet allows to access 

online TV shows, movies and music on your TV.

4. A search engine is a software program that helps the 

people find the information they are looking for online. 

They are able to return results quickly by scanning the 

internet continuously.  Popular examples of search 

engine are : 

Altavista :  http://www.altavista.com

Google : http://www.google.com

Catalog Search Engines : These search engines 

structure the information into meaningful categories. 

An example of this type of search engine is 

http://www.yahoo.com.

Index Search Engine : These search engines look for 

keywords or phrases and tries to match your entry 

against its database. 

An example is http://www.excite.com.

5. HTTP (Hyper Text Transfer Protocol) : HTTP stands 

for Hyper Text Transfer Protocol. It is the standard 

protocol for transferring web pages across the Internet. 

FTP (File Transfer Protocol) : FTP stands for File 

Transfer Protocol. It is used to transfer files across the 

Internet. FTP is commonly used by web developers to 

publish updates to a website. 

SMTP (Simple Mail Transfer Protocol) : SMTP stands 

for Simple Mail Transfer Protocol. It's a set of 

communication guidelines that allow software to 

transmit email over the Internet. The other purpose of 



SMTP is to set up communication rules between 

servers. 

F. Write the full form of the following :

1. ISP : Internet Service Provider

2. SMTP : Simple Mail Transfer Protocol

3. HTTP : Hyper Text Transfer Protocol

4. E-Commerce : Electronic Commerce

5. TCP : Transmission Control Protocol 

6. FTP : File Transfer Protocol 

7. www : World Wide Web 
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